
HTML-Optimizer 9.52
© (2000 - 2006) Tonbrand Software

Introduction
HTML-Optimizer is the basic model of a range of HTML optimizers:
- HTML-Optimizer
- HTML-Optimizer Pro
- Web Site Maestro
Each next one in the range adds more capabilities. Check it out at http://www.tonbr  a  nd.nl/products.htm  .

Short Description
HTML-Optimizer speeds up your web site by optimizing both HTML and script code of your web pages. It helps you keep 
organized by creating a duplicate site folder for the optimized files.    An added benefit is that it leaves your original files 
untouched. 
The program features Smart Handling which means that only those pages that have changed are processed.
You should use your original web folder for editing and use the duplicate web folder for uploading.
HTML-Optimizer is Unicode-savvy.
Drag and Drop is supported.

Configuring
When you start the program for the first time, a wizard will guide you through the configuration process.
A duplicate of your web folder will be put in a folder named Optimizer Output, which is by default created in the same 
folder where your web folder resides.
The concept of a duplicate web folder was chosen to protect your original web pages. The idea is that you compose and 
keep your web pages in the original web folder. The duplicate web folder is used by the program to store the optimized 
pages and is the source folder to upload from to the remote server.

Manual
The program's manual is built-in the program - see the Help menu of HTML-Optimizer.
Note that Help Tags are available for most items in the Options window.

Note for WordPress Users
If you have files in the Plugins folder you should exclude that folder from optimizing. You can do that in Options. Then, 
after having optimized your entire WordPress folder, you may optimize only the Plugins folder with the optimization 
option 'Remove multi-line script comments' turned off.

Competitors Test
A test with other HTML optimizers shows that HTML-Optimizer is the winner. Look at 
http://www.tonbrand.nl/optwinte  s  t.htm  

Shareware
HTML-Optimizer is shareware and costs USD 17.00 for a Single User License.
You can pay online via the web store Kagi at the secure page https://order.kagi.com/?U5P. It's recommended that you 
register from within the program, by choosing 'Register' from the Help menu and then pressing the 'Buy Now' button.

Limited Use if Unregistered
An unregistered copy has a time limit of 30 days and limits the number of web pages to be optimized in one pass to 50%. 
Please register in time so that you can continue working with HTML-Optimizer without delay.

License Policy
A license is 'Single User'. Your serial number will be based on your user name. You may install HTML-Optimizer on 
maximum two computers of your own, for example your desktop and laptop sharing the same user name or at least 
having user names that relate to each other, otherwise you need an extra license. Contact Tonbrand Software to request 
an additional serial number for your second computer (if required because you can't or won't change the user name).

Required
Windows 98 / ME / NT4 / 2000 / XP

Version History

Version 9.52
16 August 2006
 Improved optimizing web pages with many empty lines.
 Corrected some text in the Manual and the Tips window.

Version 9.51
18 June 2006

https://order.kagi.com/?U5P
http://www.tonbrand.nl/optwintest.htm
http://www.tonbrand.nl/products.htm


 Fixed a bug introduced with version 9.5 that could decrease the optimizing results.

Version 9.5
16 June 2006
 The drop spot on the Main Window now also accepts folders that contain HTML files. Nested folders are not 

supported.
 Added to the Options Window the option to remove all tabs.

Version 9.44
1 June 2006
 Revamped the Main Window to enhance the readability of the controls.
 Corrected truncated captions in Options when used on Windows XP.

Version 9.43
13 May 2006
 Improved optimizing HTML code with a huge amount of superfluous white space characters.
 When removing redundant editor tags, Dreamweaver elements are now also removed.
 It's no longer required having an index file in the web folder.
 It's no longer possible that files of the type "abc.htm_nav_xyz.gif" are optimized and possibly corrupted.

Version 9.42
25 April 2006
 Further improved synchronizing the duplicate web folder.
 When removing redundant editor tags, GoLive elements are now also removed.

Version 9.41
3 April 2006
 Synchronizing the duplicate web folder has been improved and adapts itself to the number of levels of the web 

folder.
 Single-line comments that contain the word "Copyright" (not case sensitive) are not removed.

Version 9.4
16 February 2006
 Improved the Preferences Window, which has now 3 tab panels.
 Added the same Excluded Folders options as in HTML-Optimizer Pro.
 Fixed some minor bugs.

Version 9.33
8 December 2005
 Corrected some inconsistent displays, dialogs and alerts

Version 9.32
18 November 2005
 Fixed a bug that could repeatedly show the configuration wizard when opening the program.
 Improved sorting the Bytes Saved column in the Log.
 Fixed a bug that could corrupt script code if the code does not comply with the official notation.

Version 9.31
21 October 2005
 Added a Show Update/Sync Log command to the Extra menu.
 The Main Window position is remembered, also when the window has been resized.
 Fixed a bug that caused that 'Removing HTML Comments' did not work.

Version 9.3
8 October 2005
 The Main Window is now resizable and any size is remembered.
 Optimizing speed for all types of script code has been dramatically increased, up to 50%.

Version 9.2
6 September 2005
 The code of the Optimizer Engine has been totally rewritten, resulting in enhanced speed and reliability.
 The processing depth is unlimited (no longer maximum 6 levels).
 Web pages in excluded folders are copied unchanged to the duplicate web folder, overwriting earlier optimized web 

pages.
 The Remove Script Comments checkbox has been split in two checkboxes: for single-line and multi-line comments.
 Supports Cache Server Pages from InterSystems.
 Supports ColdFusion from Macromedia.
 No longer causes a crash on Windows 98 and ME when dialing up to check for update.



 Improved reliability of checking tags and hyperlinks.
 Improved reliability of optimizing php files.
 Fixed a bug that could freeze the program while removing HTML comments.
 Fixed a bug that corrupted Wordpress php files.
 Fixed a bug that removed optional end tags from XHTML files.
 Fixed a false error message from the Configuration Wizard.

Version 9.11
1 June 2005
 The Configuration Wizard now gives a proper error message when a volume is chosen instead of a web folder.
 Improved the reliability of the Duplicate Web Folder Integrity Check.

Version 9.1
5 May 2005
 The program can now handle web pages with any text encoding. The 'Unicode UTF-8' radio button has become an 

'Automatic' radio button.
 Rephrased the error dialog that pops up when your web folder or the Optimizer Output folder is not found (because 

you had changed name and/or path).
 Corrected some text in the manual.

Version 9.03
16 April 2005
 Fixed a bug that closed the program if it found a special character in your user name.

Version 9.02
31 March 2005
 Hidden files are no longer optimized.
 Improved Duplicate Web Folder Integrity Check for long file names.
 Fixed a bug that could corrupt script code when removing script comments in (X)(HT)ML pages that utilize the 

Document Object Model (DOM) API.

Version 9.01
16 March 2005
 Improved optimizing web pages with many successive waste returns.
 Fixed a bug that did not allow optimizing a file from outside your web folder when Smart Handling was on.

Version 9.0
9 March 2005
 The User Interface has been much improved. Now you can watch the Log being populated with the optimizing 

results.
 The Safe Mode option is always on, so the Safe Mode checkbox has been removed.
 Improved the reliability of the Duplicate Web Folder Integrity check.
 Settings for File, Folder or Entire Web Folder are remembered.
 Fixed a bug that could prevent Flash sound applets from playing.
 Fixed a bug that corrupted Google script code.
 Fixed a bug that prevented the program from starting when the Windows or WINNT directory was not in volume C.
 Fixed a bug that could corrupt embedded css code in php files.

Version 8.4
17 November 2004
 Extended the Smart Handling feature by adding the option to handle files that have been changed since a date 

defined by the user. The previous 'Date (Today)' mode has been removed but 'Today' can easily be set in the new 
mode.

 The Smart Handling Mode display on the Main Window has been made clickable so that you can toggle between the 
two modes.

 Fixed an error that caused empty text clippings dragged from the Log.
 Extended the trial period to 30 days.

Version 8.34
5 November 2004
 Corrected a text error in the Configuration Wizard.

Version 8.33
1 November 2004
 Added a hint to the drop spot.
 Limited in an unregistered copy the number of web pages to be optimized in one pass to 50%.

Version 8.32
22 October 2004



 Fixed a bug that could truncate the text in the Smart Handling Mode display.
 Improved the layout of Optimization Options by moving some.

Version 8.31
20 October 2004
 Corrected a text layout problem that could occur when an optimized page was viewed with Internet Explorer (not 

with any other browser and never on a Mac).

Version 8.3
15 October 2004
 Improved optimizing speed.
 Made the Configuration Wizard user-friendlier.
 Help Tags can be viewed again after their timeout.
 Fixed some bugs.

Version 8.24
2 October 2004
 Fixed a bug that could make the main menu bar and the Windows task bar disappear, requiring a click on the 

desktop and then on the Main Window to bring them back.

Version 8.23
28 September 2004
 Fixed a bug that unexpectedly closed the program when scrolling in an Open Dialog to select a file or a folder - only 

under Windows XP. This bug was introduced in version 8.2.
 Web Folders that start with a leading whitespace can now also be chosen.

Version 8.22
16 September 2004
 Increased the optimizing speed in Safe Mode to the same level as the default mode.

Version 8.21
7 September 2004
 Fixed some minor bugs.

Version 8.2
30 August 2004
 Added a menu command 'Check Duplicate Web Folder Integrity' to the Extra menu. This command does a fast pre-

check to find out if the 'Update Duplicate Web Folder Contents' command - which takes more time - should be 
executed.

 Added a menu command 'Refresh Duplicate Web Folder' to the Extra menu, to be used if executing the Synchronize 
command cannot repair a corrupted duplicate web folder.

 Added the option to remove <!--# comments.
 Fixed a bug that corrupted code from AllWebMenus™ software.
 Decreased required disk space and increased speed.

Version 8.11
1 July 2004
 When you execute the Synchronize Duplicate Web Folder command, a hint to optimize certain files is not given if 

these files reside in an excluded folder.
 Fixed a cosmetic error in the About window.
 Put the version number on the Main Window.

Version 8.1
4 June 2004
 Introduced a 'Safe Mode' option that prevents cosmetic changes in web pages that do not fully comply with the 

W3C rules. Use this option only if you need it because the optimizing process will run about 60% slower. The 
'Restore Lost Space' option has been removed because it is not required any more. If you did not use this option in 
the past, you do not need to use Safe Mode now.

 Added the option to qualify URLs, i.e. put a missing trailing slash after a directory URL and replace any occurrence 
of '&amp;' in a URL with '&'. Works now also for script code.

 The current Optimizer Output path is now visible on the Main Window.
 When optimizing your entire web folder without Smart Handling, the 'Preparing' stage is skipped if after a first run 

nothing has changed in your web folder.
 Comments that start with '<!--[' are no longer removed.
 Fixed a bug that only appeared under Windows 98 / ME that scattered folder names in the Excluded Folders box in 

Options. We recommend that you re-order the names by removing the 'white' lines and then save Options.
 Revamped the program's icon.

Version 8.04



17 April 2004
 Added the ability to access a folder outside the current web folder.

Version 8.03
14 April 2004
 Fixed a bug that caused that a login name was not found if that name contains special characters.

Version 8.02
10 April 2004
 Fixed a bug that could corrupt javascript if the original code lacked one or more semicolons where required.

Version 8.01
8 April 2004
 Fixed a bug that gobbled up required white space in some rare cases.

Version 8.0
5 April 2004
 HTML-Optimizer Pro is now 'Unicode-savvy' and can work with WindowsANSI or UTF-8 files, even web pages with 

Japanese characters (double-byte characters). Default is Western WindowsANSI.
 Added Logs to display the results after executing the Update Directory, Update Contents or Synchronize Duplicate 

Web Folder commands.
 Added the ability to view the optimized web page from within the program. (Select a line in the Log first and then 

click the View Page button)

Version 7.93
12 February 2004
 Fixed a bug that caused that percentage values of tags were at random replaced by a < character when ASP code 

was involved.
 Fixed a bug that could corrupt strings in PHP script code.

Version 7.92
28 January 2004
 Fixed an error that caused a delay of several seconds - up to half a minute -    when switching between large web 

folders or turning on Smart Handling for a large web folder.

Version 7.91
23 December 2003
 Fixed a bug that caused 2-byte characters, e.g. Japanese, to be corrupted. (This bug was introduced by the 

previous version)

Version 7.9
18 November 2003
 Added the ability to optimize ASP script code.
 Drastically improved the speed of removing multiple white space when you are using a non-Western OS, e.g. 

Japanese.
 Fixed a bug that inadvertently removed \n characters from PHP code.

Version 7.82
23 October 2003
 Improved the layout of the Main Window.
 Fixed a bug that could cause optimized web pages in the duplicate web folder to be overwritten by the original 

pages when executing the Update Contents or Synchronize Duplicate web Folder command.
 Fixed a bug that caused that the countdown timer in the Register Reminder continued with negative numbers when 

the RR window was not kept in the foreground.

Version 7.81
15 October 2003
 Fixed a bug that could cause an infinite loop error when encoding email addresses.

Version 7.8
2 October 2003
 Added the ability to drag the contents of the current Log - not the History Log - to a text editor's window, e.g. 

WordPad (not Notepad).    If the font type is non-proportional, e.g. Courier, the columns are lined up.
 Added a popup display next to the Smart Handling checkbox that indicates the current Smart Handling mode.
 Added the option to restore lost white space.
 Improved removing single line comments from script code (dotted lines like //---------- are now also removed).
 Fixed a bug that could cause all files and folders in the duplicate web folder to be deleted when executing the 

Synchronize Duplicate Web Folder menu command (The Update Contents menu command could restore all, 



though). 
 Fixed a bug that could move images in tables over one pixel.
 Fixed an error with the keyboard shortcut of the Manual's Find button.

Version 7.71
10 September 2003
 Added the option to encode email addresses to protect these from spam harvesters.
 Fixed a number of bugs that were introduced by the new compiler since version 7.6.

Version 7.7
30 August 2003
 Added the option to automatically check for an update of the program.
 Fixed a bug that could corrupt PHP code.
 Fixed some minor bugs related to PHP optimizing.

Version 7.61
15 August 2003
 Fixed a bug that could corrupt css code.

Version 7.6
22 July 2003
 Built by new Win32 compiler, resulting in very stable operation.
 Safeguarded by a unique product identification code.
 The user can adjust column widths in the Log.

Version 7.52
29 June 2003
 Fixed an error caused by the previous bug fix.

Version 7.51
26 June 2003
 Fixed a bug that could corrupt PHP code.
 The option to remove comments from script code now includes shell-style ("#") comments.

Version 7.5
19 June 2003
 Fixed a security issue.

Version 7.4
31 May 2003
 Reliable optimizing of JavaScript (.js) and VisualBasicScript (.vbs) files.

Version 7.32
14 May 2003
 Fixed a bug in the script optimizer engine.

Version 7.31
27 April 2003
 Made sure that the newly installed copy recognizes a previous registration.

Version 7.3
12 April 2003
 Fixed a severe bug that existed in all previous versions, that could crash your PC. This version is secure. It is highly 

recommended that you uninstall any older version if you are not going to install this new one.

Version 7.2
15 February 2003
 Improved the optimizer engine that handles script code, e.g. JavaScript and VBScript.

Version 7.11
8 February 2003
 Fixed a bug that could corrupt script code when adding Width/Height attributes.
 Added a tip to the Tips window.

Version 7.1
25 January 2003
 Smart handling can be data + time sensitive or current date sensitive, at choice.
 Fixed a bug that corrupted script code when removing script comments.



 Added a Tips window that appears at startup.

Version 7.01
23 December 2002
 Fixed an error that caused that registered users could not enter their registration code. If you still have problems, 

restart your PC.

Version 7.0
20 December 2002
 The program has been simplified so that it's easier to use and better fits within our range of optimizers.
 The functions Check Tags, Check Links and Convert Special Characters have been skipped. These functions are 

now only available in HTML-Optimizer Pro and Web Site Maestro.
 Smart Handling has been improved and is now date + time sensitive.

Version 6.21
30 November 2002
 Added support for .vbs files.
 Removes META GENERATOR tags by default.

Version 6.2
19 October 2002
 Added a wizard that leads you through the configuration process at first startup.
 Added a Test Web Folder that demonstrates the program's functions in conjunction with the Tutorial.
 Made the setup file much smaller by not including the Windows Installer 2.0 Engine but enabling automatic 

downloading the Installer Engine while installing HTML-Optimizer (only if required for your computer).
 Improved the optimizer engine.
 Optimized the application for use with Windows XP.
 Fixed some bugs related to working with XHTML files.
 Fixed a bug in the Synchronizing Duplicate Web Folder command.
 Fixed a bug when saving changes to the original file.
 Fixed a bug that quitted the application at startup in the last part of the trial period.
 Fixed a number of minor bugs.

Version 6.1
30 August 2002
 The program is distributed as InstallShield® single-image setup for easy installing and uninstalling.
 Added a separate HTML Manual - identical to the manual in the program.
 Added a Tutorial for First-Users.
 Added a Save File command to the File menu that does the same as pressing the Hide button after editing text but 

without a dialog.
 Added a menu command "Check for Update" to the Help menu.
 Made the menu command 'Choose New Web Folder...' more user-friendly.
 Any script code between <? and ?> tags is now dealt with separate from the main HTML code and can be controlled 

by the upper two Script checkboxes in Optimization Options in Preferences.
 Fixed a bug in the 'Adding missing width and height attributes' option that caused that it did not work for (graphic) 

files with a relative path (in subfolders with own index file).
 Improved the 'Adding missing width and height attributes' option in such a way that it can add a Height attribute if 

only the Width attribute is present or add a Width attribute if only the Height attribute is present (previously it only 
added both if both were not present)

 Fixed a bug that caused that space was unintentionally removed from text in some cases.
 Fixed a bug that could cause the program to hang when removing redundant editor tags.
 Fixed a bug that corrupted php script.
 Fixed a 'File not found' error when handling a file from outside the web folder.
 Added the option to remove spurious white space caused by some HTML Editors.
 Corrected a wrong comment caption in the 'Remove Comments from (X)HTML Code' checkbox in the Preferences 

window.
 Removed the option to add missing </P> tags because it proved to be unreliable.
 Removed the possibility to choose the web folder to hold the Optimizer Output folder, because this would lead to 

copying the same files until the disk was full or an error occurred.

Version 6.0
First release of the totally rewritten application on 20 May 2002.
Originally this program was only available for Apple Macintosh.

Legal Stuff
HTML-Optimizer is provided "as is", without warranty of any kind, express or implied, including but not limited to the 
warranties of merchantability, fitness for a particular purpose and non-infringement. In no event shall the Author be liable 
for any claim, damages or other liability, whether in an action of contract, tort or otherwise, arising from, out of or in 
connection with HTML-Optimizer or the use or other dealings in HTML-Optimizer.



A user license is personal and giving the registration code to another person or making it public in any way is illegal.

Who is the Author?
HTML-Optimizer was developed by Ton Brand from Tonbrand Software in the Netherlands. Since 1995, Tonbrand has 
offered a variety of freeware and shareware applications.
This program was written in REALbasic (the program was initially written for the Apple Macintosh platform). REALbasic 
can be compared to Visual Basic.

Web site: http://www.tonbrand.nl
Contact: mailto:info@tonbrand.nl
Bug reports: mailto:bugs@tonbrand.nl
Support: mailto:support@tonbrand.nl

REALbasic is a trademark of REAL Software, Inc.
Visual Basic is a trademark of Microsoft Corporation
InstallShield is a trademark of InstallShield Software Corporation
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